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1. Flow Chart to Measurement

Device connection

Calibration with sensors

\

Bar graph display
PAVE and PSUM operation
Level trend operation

V

Level trend 3D display

Lx display

v

Saving data

Copying and outputting data

Connect a sound level meter or microphone to
the DS unit. Perform sound pressure calibration
with each sensor.

Perform real-time octave band display, power
averaging, and level trend operation.

Display level trend 3D diagram and Lx
(percentile sound pressure level).

Save and output data.
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2. Device Connections

2-1 Device Connections

Connect the DS main unit and the PC.

Personal computer (notebook)

DS-2000 rear panel

ONOLINK 11
— PCMCIA

— [ 0
| ]

Key protector
(USB or parallel)

o

! |
100VAC 100VAC
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2-2 Connecting a Detector

* When the MI-1211 and MI1-3210 are
used, an option for direct input
(DS-0286/0287) is available.

* When the MI-1211 and MI-3210 are
combined, use the SR-1100
Microphone preamplifier.

NS

* When the M1-1233/1431 and MI-3110 are combined,
use BNC cables for direct connection.

* With the LA Series sound level meter, connect the AC output and the input
section at the bottom of the DS-2000 with a supplied cable.




3. Real-time Octave Analysis Setup

3-1 Input Source Setup
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Select an input source depending on a sensor used. When using a constant-current microphone (a
combination of the MI-1233/1431 and MI-3110), select a constant current of 2.0mA.
Select “Voltage range” from the “Input” menu.

[nput  Anabysis  Display  Mode
Ctri+F

Crl+y

| Octave set
-l Woltage range.
Time Constant.
Trigger.
Unit/Calibration
User Filter..

Measurement Time..
Level Trend Time...
Octave Tracking

Signal Out.

Remote Box..

Source Conditions

Octave Voltage Range |Time Constant |

For Input Source, select a signal
source suitable for the sensor type.

Range Source Offset Tyvpe

Chi: |0dB ~| BNC ~| |0dB ~v||log *|
BNC

SENSOR(Z.0mA 1088 ] |Log =]
MIC

SENSOR(4.0mA 0dB =] log x|

Chd: |0dB ~| |BNC | |0dB | |log ~|

I~ &l Channels

Ok, | Cancel

3-2 Display Layout Setup

Select the number of screens to be displayed in and a screen layout of the measurement screen.

Display  Mode Offline
wpp Display Lavout...
Display data select...

H-Pdis set.
Y—fois set..

Cursor set...
Graph set..

Comment set...

Select a screen layout
(horizontal and vertical
arrangements).

Select the number of screens.

Screen Mode

Dual -

@Jisplay Format Selection (12

I~ Digplay in channel order

25

OK Cancel | e

240

30

292277

Tl 2|30 |

12 | 2x2 |32 | dx2 | Dx2 |Ox2 e

%3 | 2x3 3 3
Pl | 2 | 3xd | dxd | Sxd | 6xd | Ted Bed

x5
I
7
I

* When multiple screens are displayed, left-click the comment area at the top left of each screen to

activate it.

/3
dE

=CH1,INST
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3-3 Calibration with Sensor

Perform calibration with a microphone. In the case of using a sound level meter, press the CAL
button to output a calibration signal. When a microphone is connected, insert the calibrator into the
microphone and output the calibration signal. (Do not change the level range after calibration.)
Make sure that the sensitivity of the input signal is not exceeded.

OGT GHT «|  SENCmA)
[1/3 |126ms(Fast) ~ ||[0dB = |

2006 Decreases the sensitivity.

Gk MEM LM| @ ]_mugga

Select a sensitivity so that this I S

indicator does not light up in red. i

Increases the sensitivity.

Select “Unit/Calibration” from the “Input” menu.

Input  Aralysis Display  Mede

Octave sat.. Ctri+F
Voltage rangs CtrHy E Press the Cal. button.
Time Constant...
Trigger..

> |Init/Calibration.. s . . 1
Q;;rﬁt;:' o Unit/Calibration
Measurement Time ’—4|
Level Trend Time.. Ch 1 hd 100 Sqve
Octave Tracking.. 3 Data |IMST - Ldad
Signal OQut. | Time m . D
Remote Bowx. |

— Band |Allpass Cal.

’@ 10045 :Iv = ?naall.bled
2 A
— Type [dB/SP = f
For calibration band, -
select AIIpass. ! Current ¥:  Allpass 24.0 dB| _
Unit Name o] Value [94 @Se’r Defaut| §U Change|
0]4 Cancel
Enter a calibration value from the Check Cal. Enabled.

keyboard or a numerical keypad which is
displayed by clicking the [...] button.
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3-4 Displaying Instantaneous Data

Perform various setup of real-time octave analysis.

Select an input channel.

y
0cT  @|cH ~| SENG@mA!
|1f3Tj 125ms{Fast) » ||-20dE ~ |

Select 1/1 or 1/3. Select a time constant
(movement of bar graph):
10ms, 35ms, 125ms (Fast),
630ms, 1s (Slow), 8s, or

Impuls.
Set a display range of the Y-axis.
Select “Y-Axis set” from the “Display” menu.
Display Mode Offline . ..
¢ Display Lavout.. XY AX|5 CO"d't'QnS
| Display data select... :
X-Aods set.. | K-fus V- Axis ]Trend K~ s |
— - s set ]
Digplay Level Range
Cursor set...
Graph set... > Upper 100dE -
Comment set..

» Range
Set an upper-limit value

and display range of the X
axis.

T Set All 0K | Cancel
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Similarly, select “Display data select” from the “Display” menu.

Display  Mode  Offline

t  Display Lavout
P Display data select. . Select Graph'
| M-Axis set.
Y—Axis set..
Display Data Conditions
Cursor get...
Qraph set.. Band Data | Moritor | Trend Data|
Comment set.. \4
Display Mode |Single - Display Type |Graph -
] Datal
Select a display channel. |~ sqyrce  |Current -
Channel ~ |1 -
Type INST -
Select INST for //mgghﬁng
instantaneous data FLAT - AT <]
=

I~ Sgtoall \ OK | Cancel

For microphone input, check Set a frequency-weighting filter. If A-
this box to apply A- weighting is set in the sound level meter,
weighting only to overall. select FLAT.

o
.
-
5

dB =CHL,INET

EU ‘ ‘
3 83.0 1Zs z50 500 [ 2.k 4o 8. 3

3L.5 1.0k l6.0k A
¥:Overall Y: 82.07dB(A) Hz

=
=}

@
o

o
o

-
o
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3-5 Calculating Power Average (Equivalent Sound Level Leq)

Select “Measurement Time” from the “Input” menu.

Input  Anahsis  Display hMode .
| Octave sat. CtrlF Enter a measurement time.
1 VYoltage range... S
Time Constant.. .
Trigger.. Measurement Time .%

Unit/Calibration...
User Filter..

1 \
= hieasurement Time.. ’D—Jh |EI JI‘H |1|:|

Lewvel Trend Time...
Octave Tracking..

Signal Dut...

Ok, ‘ Cancel

Femote Bowx.

Inverted during operation.

ﬁ PLUSE| STOP | TRIG a0z Remaining
-"'}I L B m] 0:00:08 0:00:02

Press the START tool button.

- — e wien

Display Data Conditions
Band Dafa \ Monitor | Trend Data |
Select “Display data Display Mode |Sing|e ﬂ Display Type |Graph =
select” from the Datal
“Display” menu, and Source  |Current - ’ﬁ
select P.AVG for
Type. When P.SUM is [7] Chamnel |1 Kl ¥
input, the power Type )
summation value is Freq.weighting
displayed. FL—_|AT - ’—_|

& -weight for Overall -

=] =
r Set Al Cancel
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Power average display

8| 173
O =] =CH1 PAYG

100
35 63.0 15 280 50 1.0k 2.0k 4.k 3k 160k
Hz

XOwerall ¥ 220642

a0

80

ES
=)

a
o

s
=1

Power sum total value display

=T 173
o

de =CHI1 F.SLM

100
630 125 280 500 1.0k 2.0k 4.0k 8.0k 160k
Hz

@
o

-
o

@
=1

@
=1

.
o

316
KOwerall ¥ 02.064E



3-6 Level Trend Analysis
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Level trend analysis is performed to analyze how each band level changes with time.
Select “Level Trend Time” from the “Input” menu.

Input  Analysis  Display Meode
1 Octave set.. Ctr+F
1 Weoltage rangs.. Ctrky

Time Constant..
Trigger..

Unit/Calibration...
User Filter..

Measurement Tims..
Level Trend Time...
Octave Tracking..

Signal Cut...

Select a sampling interval f
1ms to 10s.

rom

Level Trend

Sampling

Trend 2000 data):

N

10 Seconds

Remote Bow.

S—r

- Use fime constant gépend on
ampling interyal
QK | Cancel |

interval x 2000 (points).

Trend time length is determined by set Time

Set the trend mode and then start trend analysis. When the measurement time has elapsed, trend
analysis automatically stops and trend operation starts.

v
PAUSE| STOP
[ R

\

TRIG
=

|‘

Select “Display data select” from the “Display” menu.

Select this
tab.

Display Data Conditions

Datal
Source Current -
Channel |1 -
Type INST -
Freq.weighting
FLAT -

v A-weight for Cverall

1
Band-Batartomitor | Trend Data|

Display Mode |Single -

Display Type |Trend €—=

[Current—— ~]
[ =
Nt ]

Flar ]
=

-

Ok | Cancel

Select Trend.

10



Select the number of display data items.

7

Display Data Conditigns
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Select frequency
weighting.

d

Band DaTa] Monitar Tre DaTa}
WNumber Of Lines |4 -

Select line color

hannel Band Freq.weighting Color
Line1: 1~ [overal  ~|[a-weight ~| [l ~] T
line?: I T —-‘
Line3: 1 | [aokHz  ~[[FLar <] [ =] ——‘
Line4: N | [smoHz  ~[FLaT ]
A A
Cancel

respectively.

Set channel.

Select a band subjected to trend data display.

Select “Trend XY-Axis set” from the “Display”

N=dods | Y-tads Trend XY—Asds |

Display Level Range

menu.

Since the initial value is 400,
click [...] and enter 2000.

Input Numeri;é(

=
Select an i
upper-limit ‘|—> Max Level |90dB - ] |
level and a
—» Range o0dB -
range. - 7 o R =7 e
Display Section Range 4 | 5 | 6 |
Start Point [0 =0 i E e
Range [0 = J»/ ol | ok | cance
Section.000: - Z.000s I
T Set Al Ok ‘ Cancel J

11




Level trend data
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i i I!

3D display of level trend

Dual Le?el Trend | x|

Select the Level Trend tab at the top left of the measurement screen.

Select “3D Trend” from the “Display” menu.

bode  Offline

H=Pwis set.
Y—Pods set
P Trend X—Axis set..
Cursor set..
Graph set...

Comment set..

Select frequency weighting.

|
Display Data Conditions | |4

2D graph can be also
selected.

3D Trend |
Source IDirech vl Freq.weighting IFLAT vl
~Direct Data
Channel |1 vl
——~—Display Format 2D Flot

moomr 3D = R
[]

X:Band/Y:Time can
be also selected.

WX:TimeN:Bamd || ||monot =

Cancel

12
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Open Trend XY Axis Conditions.

Select Upper-limit level and Range
same as level trend setup.

X=Axis | ¥-Asis Trend XY-Axis |
~Digplay Level Range

Max Level [90dB = /
e
Range IéDdB vl

-Digplay Section Range
Start Paint ||] EJ The initial value is 400 same as

—— [ level trend setup, so enter 2000
(1999 is automatically displayed).

Section0.000s - 9.995s

I~ Set all K icancel

[

* Qut of data for 2000 points, 1/3 octave band data for any desired point and level trend data for
any desired band are displayed by using the cursor.

13



Displaying Lx
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Lx operation for each band can be displayed using data for 2000 points sampled in level trend
analysis. Lx indicates the percentile sound pressure level with which the number (frequency) of
sampled data for each level is obtained. The DS-2000 simultaneously displays L1, L5, L10, L50,

L90, L95, L99, Lmax, Lmin, and Lavg for each band.

Huadrupld Level Trendl [ 4—'* Select the Lx tab.

Select “Lx Data Display” from the “Display” menu.
Display  Mode Offline
=P | Data Display..

Select the number of data to be displayed.

— Trand XY—-Ffxdis set..

e ! Display Data|Conditions

Graph set...

L Data Display ]
v

L Number 10 -

Channel Data

Comment set...

Color

tnet: [T [0 <[] ~ [ =1 =

i <]

line2: [T ~|[l5 ~||

7] [ FL T

Select line color for L1 to

Hred—t—~ T[T~ |

= E_=

Since the initial value is
400, and enter 2000.

Lavg.by using the scroll bar. lined: {1 ~| {150 =[]

L Start 0 =
L« Length 1999 =] I Display Trend Data

| ime: 0.000s - 9.995

- Da) K1

Ok | Cancel

XY Axis Conditions

X=txis | Y-Axis Trend X¥—huis |
Display Level Range
Max Level |P0dB -

T | Range 606~

Display Section Range

Start Point |0 =
Range 1959 _,3

Sectiondl.000s - 9.9%95s

™ Set Al oK, Cancel

Open “Trend XY-Axis set.” Then,
select Upper-limit level and Range
same as level trend setup.

14
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* Lx display for each band at 1kHz

Displays L1, L5, L10, L50, L90, L95, L99, Lmax, Lmin, and Lavg for each band. L1 to Lavg are
connected for each band.

15
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4. Outputting and Saving Data

4-1 Saving Display Data

This function saves the power averaging data, power total value, and other graph data displayed in
the measurement screen. (Trend data is saved by another operation.)

Select “Data Save” from the “File” menu.

File Edit Input Analysis Display
Panel Memory... o

Block Memary..
Auto Memory..
=P [Data Save..

Qpen for Offline...
Recent for Offline Eile 4

I

Brint... Ctr+P
FrintPreiiew. .

Frinterset...

Page Lavout...

Exit

Specify file name. Click Save to save data.
ZEETHTIRTE
(FEIDHAC | [ Bkbem = |
data.spd

datai0! spd
datalll zpd

datall2 zpd
datall3.zpd
27 B I EXEdy] |
TP ILDIERTE | thspd) =l gl |

4

* Although the file name extension is only .spd, the saved file is a text
file and therefore can be loaded in Excel, etc.

4-2 Loading Saved Data

Data saved in a file can be loaded through the block memory.

Select “Block Memory” from the “Input” menu.

Block Memory

Select a block No. in which a

file is to be loaded.

Address | Type | ch | Comment

No dafa

Date|~
__—Towel

Mo data
Mo data
Mo data
Mo data
Mo data
Mo data
Mo data
Mo data

W Azt

]

[ I = N B T

Store ‘ Regall | Clear | e

[ loady] s
Edit Comment || Selcet Al | -\0a S 0K | Cancel |I

>

I~ Auto Store

Press the Recall button to load the file.

Set the file to be loaded in the specified block No.

16



4-3 Saving Level Trend Data
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Level trend data is temporarily saved in the auto memory. The level trend data saved in the auto

memory can be saved in a file.

Select “Auto Memory” from the “Input” menu.

Auto Memory

Auto Memory
Comment :

|New Data

Channel|1 =

save to Disk
Comment :

Clear |

Load ‘

|New Data

Channel |1 =
A

lx Save as fext -

Ve

Disp Sa\re‘ L

L

Al Channel Save

B ave |

Ok ‘ Cancel‘

e

Set a comment as required. The
comment is reflected when a file is
loaded.

Select a channel of saved
data.

Check this box to save data in a
text file (that cannot be reloaded
by the application).

v

HMEMTOTRTF K4 B3
{RETBBRI0: [ AutoMem = =
FrA LR N \_ﬁi@&l
F7AILDAERRTE /[ Trend Files Gt =l #j)t,lb |

4

/

Specify file name.

17

Press Save to save data.
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4-4 Loading Level Trend Data

The following procedure loads and displays level trend data saved in a file.
Select “Auto Memory” from the “Input” menu just as when saving the data.

Auto Memory ﬁ

Auto Memory
Comment :

|New Data

Ch 11 =
e Clear [C load D

save to Disk
Comment :

|New Data J
Channel |1 = Al Channel Save

I Save as fext -

Disp Sa\re‘ L Shve |

Ok ‘ Cencel‘

\4
B 7] x|

FrAMOERO [ AutoMen = =

TN Jtesttrc RS Oy I

IPAILDTERRTE [ Trend Files thre) R s

v

Select a file to be loaded.

Press Open to load the file.

18



After determining the data format with “Copy set,” select “Copy” from the “Edit” menu.

4-5 Copy Function
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Measurement data can be temporarily put in the clipboard. The data in the clipboard can be easily

pasted to other applications without saving.
Select “Copy set” from the “Edit” menu.

Edit  Input  Analysis

Copy set...
Copy Ctri+C

Copy Conditions

|+ Bit Map
" Text

Select Bit Map or Text /’ ®

using the option buttons.

Condition Data
 ON/OFF " OFF
K- Axis Only
Y= Axis Only

v W= s

1 apply the

CAUTION:

1.
2.
3.

The copyright of this procedure manual is reserved by Ono Sokki Co., Ltd.
Duplication without prior permission is prohibited.

Click OK to

settings.

This procedure manual explains general measurement procedures. Ono Sokki assumes no
responsibility for data obtained through a specific operation performed by the customer.
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